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GETTING STARTED 

 

What is LRM? 
LRM, short for Land Resources Manager, is a Forest Management Information System framework 
developed by Trimble® and customized to meet TTG Forestry needs. LRM is an intuitive and easy-to-use 
application for managing operational information and accessing tabular and spatial information. LRM has 
been used by TTG Forestry since March 2018. The current version is LRM 5.5. 
 

Getting help 
Who to Contact?  

BTG IT Support Help with questions like:  

• My login/password is not working 

• My password is expired 

• Need to reset my password 

• Can’t copy files 

• I don’t have access to something I 
should have 

Phone: 212 441 3099 
E-mail: support_us@btgpactual.com  
 

LRM Support Help with questions and issues like: 
• I have a question regarding data entry 
• LRM System errors 
• I have a contract question. 
• I need help getting data from LRM 
• I have an error message. 
• I have a reconcile error in my LRM 

status bar 

Phone: 404 789 1951 
E-mail: lrm.support@ttgforestry.com 
https://www.ttgforestry.com/lrm_self_training/ 
 
 
neil.verplanck@ttgforestry.com (Inventory and harvesting 
contract questions) 

TTG Edits Use this e-mail to request map updates, send 
Inventory loads, budgets, Map corrections, 
shapefiles, land sales, surveys, any data change 
request needed in LRM (for contracts use the 
lrm.support email above). 

• ttg_edits@ttgforestry.com 

Fund Admin Accounting, Fund Admin, D365, and others 

• BTG Compliance Approval 

• Legal Contracts 

• New Vendors setup 
• New Customers Setup 

• SH-FundAdmin-Timber@btgpactual.com 

• OL-Timberland-Compliance@btgpactual.com 

• SH-FundAdmin-contracts@btgpactual.com 
• Donna.Cavaliere@btgpactual.com 

• amanda.fulk@btgpactual.com 

Glossary 
 

DUT or WebDUT Database Update Template. A web form that 
foresters use for reporting completed silviculture 
and harvesting activities.  
https://pam-ttg.azurewebsites.net/ 

SO 
 
 

PO 

SO: The same as Timber Sale Contract. SO is the 
term used in D365 and means sales order. 
PO: The same as Silviculture Contract. PO is the 
term used in D365 and means purchase order. 
 

D365 The accounting system managed by the fund 
services group. 

 AVD Azure Virtual Desktop. A solution to deliver the TTG 
LRM application hosted in the cloud, to all users 
using the Browser or a connector. 

https://www.ttgforestry.com/lrm_self_training/
mailto:neil.verplanck@ttgforestry.com
mailto:ttg_edits@ttgforestry.com
mailto:SH-FundAdmin-Timber@btgpactual.com
mailto:SH-FundAdmin-contracts@btgpactual.com
mailto:Donna.Cavaliere@btgpactual.com
mailto:amanda.fulk@btgpactual.com
https://pam-ttg.azurewebsites.net/
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Accessing the System 
LRM System sits on the TTG Cloud, which is hosted by Microsoft Azure. To gain access to the system, a 
user must first request an account and be set up by the IT department and LRM Support, whose contact 
information you can see on page 3. 
 
First Access: TTG users will use their current network username and password. New external users will 
receive their usernames (which will be an email address) and a temporary password from IT. Follow the 
steps below to gain access.  
 
Starting in August 2023, the AVD (Azure Virtual Desktop) is the new way to access resources in the TTG 
Azure Cloud.  
 

 
• Open your browser (Chrome or Edge) and navigate to https://www.ttgforestry.com 

• On the TTG website, click “the computer icon” link in the top bar as shown below: 

 
 

• Alternatively you can type  https://www.ttgforestry.com/remote and bookmark/favorite it. TTG 
employees will use their regular email and password to sign in. Other first-time users will enter the 
username and the temporary password provided by IT.  
 

https://www.ttgforestry.com/
https://www.ttgforestry.com/remote
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• Important: Enter your username as the email (even if you don’t have access to that email). The BTG IT 
department handles that. If you password or username doesn’t work or is expired, contact 
support_us@btgpactual.com and request for help. It’s always a good idea to also copy 
lrm.support@ttgforestry.com so they know of the issue and can expedite assistance. 

 

 

• Once you’re signed on, you should see at least these three icons below. If you don’t, please contact both 
IT and LRM support. 

 
 

The AVD peculiarities 
Before moving on, you need to know that, starting in August 2023, AVD replaced RDWeb as the way to 
access LRM and Maps&Files. Now you can access LRM directly in a browser, but you can also use an 
RDP connector, like before. 

mailto:support_us@btgpactual.com
mailto:lrm.support@ttgforestry.com
https://client.wvd.microsoft.com/arm/webclient/index.html
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Using LRM in the browser 
You can use LRM and Maps&Files in the browser now, from any 
computer connected to the internet.  
This is the preferred way to access LRM; the only downside is 
copying and pasting files from AVD to your PC with Ctrl+C and 
Ctrl+V doesn’t work. You must use the Azure Virtual Drive to 
download files (more ahead or click here to see it now). 

 

Using RDP connector to remote to LRM 
 
If you choose “Download the RDP file”, you’ll need to have the 
new RDP Red connector client installed in your computer. Ask 
your IT to install it from the link below.  
Choosing this option, copy and paste works and it works just like 
the RDP connector you used to use before the upgrade. Download 
the connector, double click, sign in and use LRM. 
 

Microsoft Remote Desktop Connector- Microsoft Store Apps 

 
 
 
 

Signing into Maps and Files 
 
To get started, click on the AVD icon “Maps and Files PROD” to get it opened. 

 
You’ll need to sign in again… 

  

https://techcommunity.microsoft.com/t5/azure-virtual-desktop/wvd-web-client-file-upload-download/m-p/2282634
https://apps.microsoft.com/store/detail/microsoft-remote-desktop/9WZDNCRFJ3PS?hl=en-us&gl=us&rtc=1
https://apps.microsoft.com/store/detail/microsoft-remote-desktop/9WZDNCRFJ3PS?hl=en-us&gl=us&rtc=1
https://apps.microsoft.com/store/detail/microsoft-remote-desktop/9WZDNCRFJ3PS?hl=en-us&gl=us&rtc=1
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 “MAPS AND FILES” REMOTE FOLDER 
 
-The “Maps and Files PROD” remote cloud folder is where you’ll click to connect and have access to 
current shapefiles, PDF Maps, templates for several documents, Quarterly Summary Reports, kmz files, 
Silviculture database update template, Stand Lister crosswalk with old stand numbers when that is 
necessary, on-demand mmpk files for the Field Maps app, among other things. Always check to see if you 
have updated files there after every quarter-end. 
Never open a file directly in the cloud computer. Copy to your desktop first. 
 
If using AVD Web, copy the pdf files and paste on to RemoteDesktop Virtual Drive>Downloads 

 
 

AVD WEB CLIENT: Saving Reports and Map Files to your computer 
If you’re using the Web version of AVD, you cannot save reports and maps directly to the Virtual 

Drive and Download. You cannot access your local drives as well. (Use the Red connector for it) 
If you want to use the AVD Web version, you have to use the Virtual Drive to download and upload file to 
and from the LRM Server. To download, save the reports or maps to C:/Temporary on the C drive of the 
Remote Computer. Then, after saved, you can go to Maps & Files and copy/paste the files to the Virtual 
Drive>Downloads. The browser will ask you to download like any other file you download from the web 

  
 

CREATING A NEW DESKTOP SHORTCUT FOR LRM PROD 

CREATING AN RDP CONNECTION WITH THE NEW AVD LRM 5.5

➢ If you chose “Download the rdpw file” on page 6, you’ll need to have the new RDP Red connector 

https://go.microsoft.com/fwlink/?linkid=2139369
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client installed on your computer. Ask your IT to install it from the link on page 6.  

➢ Select that option in AVD settings and close the panel on the right. Now click on the LRM PROD 
icon and Maps&Files Prod icon to download an rdpw file. This file only opens with the “Red AVD 
connector” so you need to have it installed. 

➢  
➢ Those connectors will probably be saved in your “Downloads” folder. Cut and paste them on 

your desktop if you prefer. They will be the shortcuts to launch LRM and the Files later. 

They will look like this if you have the connector installed: 

 
 

Launch LRM with a double-click of the first icon. Sign in. 

If you see a message like this one below, please contact BTG IT support 
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You now should see the LRM user interface - image below. If you have any problems in any steps before, 
contact LRM Support. 

 

THE LRM USER INTERFACE 

 

Please pay attention to the text balloons. They will be mentioned later on. 

 
RESET LAYOUT BUTTON: This is one of the most useful buttons in the interface. LRM uses a floating-
docking window type which means you can drag and drop and dock them wherever you want on the 
screen to make the best use of your screen space. This is useful also if you have two monitors. 
However, sometimes when you do that your interface gets messy and panels start to be hidden behind 
one another. You’ll want to reset the layout back to its default state (like the image above). You can click 
on the “Reset Layout” button on the Home menu and it will be restored to the default state every time 
you feel like you need to reorganize things on the screen (when you do that, you have to re-do the panel 
docking referred on Troubleshooting #3) 
 
 

Message Board:  Version 5.5 also has “The 

message board”. Important communication between 
LRM admin staff and LRM users will be done through 
this window. Please pay attention to these messages 
that are updated periodically and contact LRM Support 
if you have any questions about them.  

Ribbon Menu 

Tree View 

Working Set 
(Bookmarks) 

Version Status 

Reset Layout 

MENU 
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LRM LIFECYCLE OF A STAND 
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CONTRACT MANAGEMENT 

Silviculture Contracts (aka P.O.) 
 

1- ADDING A NEW SILVICULTURE ACTIVITY: The first step to enter a new Silviculture Contract is to open 

LRM and, on the Tree View on the left, navigate to the PU (Purchase Unit), Tract, and Stand(s) that you 

want to work with. If you have budgeted the activities during the last budgeting season, they will be 

under the corresponding budgeted year node.  

Under the stand, you will see two entries. One will be “Current year – PU name – Non-Budgeted” and the 

other will be “Current year – PU name –Budgeted”. If you have budgeted the silviculture activity you 

should find it in the current year budgeted plan. If haven’t budgeted, you’ll have to manually add the 

activity on a non-budgeted silviculture activity for that stand. For that, just right-click the corresponding 

node (or the historical node if none is available) point to New> Activity Silv, and add it. If the node is not 

there yet, use the historic node and LRM will place it in the right spot when you save it. 

 

 
 
 
 
 
 
 

 
 
 
  
 
 

If you don’t find a 
budgeted or non-budgeted 
node, right click the 
historic one. 
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2- When you find the budgeted silviculture activity (or if 
you add a non-budgeted one), make sure 
it is the correct activity and the correct 
stand, and that the price is correct. If 
prices and quantities aren’t up-to-date, 
you’ll be able to adjust them in the 
contract itself later in step 6. 
 
 

3- ACTIVATING THE SILV JOB: Switch the 

status field of the activity from “Planned” to “Active” and save it. This step is necessary, or you won’t see 

the activities later when you try to add the stands to the contract. Do it for all the activities and for all the 

stands that will be in this contract. 

 

4- CREATIN THE CONTRACT HEADER: To initiate a new Silviculture Contract, right-click on the Purchase 
Unit you’ll be creating a contract for and point to New > Silviculture Contracts. 
 
 
 
 

5- FILLING OUT CONTRACT HEADER: Fill out the contract header fields. If you don’t find your vendor on 
the list, please contact Fund Services and LRM Support. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6- On the Silviculture Activities tab under the contract, select the stands and the activities you’ve set to 

“Active” in Step 3. Also, pick the start and end date, and enter quantity, rates, and units of measure. 

This information will be placed in the contract, and they should match. Save changes as you go. 
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7- SENDING THE CONTRACT TO ACCOUNTING: Double-check everything. Once everything 

seems to be correct, change the STATUS field on the contract header to “Send to D365.” Save the 

changes and Post your version (File>Version>Post version).  

LRM will then link up with the accounting system requesting the official contract creation. Once 

Fund Services approves the contract, you’ll see the D365 fields in the contract header filled out with 

code, creation date, and a confirmation code and the status will be automatically set to Active. 

This is your indication that the contract is ready to be executed. Activity information (actualization) 

will be reported to TTG_Edits using the BTG’s Database Update Template file (on the remote folder) 

and that information will be available in the budgeted or non-budgeted plan under the activity’s 

Chemical Actual tab, Silv. Actual and Silv. Actual D365 tab. 

 

8- REQUEST PAYMENTS TO INVOICES: Please refer to the next payment request that must be made. 
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PAYMENT REQUESTS IN LRM 
 

To prevent any future invoices from being overlooked or missed, TTG has implemented some safety nets 

to prevent this from happening. Fund Services will receive an email notification from LRM when a 

purchase order (PO aka Silv. contract) has been invoiced by the FSP. The email subject lists “Payment has 

been requested” and the body of the email lists who requested the payment (the FSP’s name), the 

quantity being invoiced, the PO number listed, and the Stand. 

 
Fund Services also has access to a “Silviculture Contract Activities sent to D365” report that lists pertinent 

information after a PO has been invoiced in LRM. This is checked in the morning and afternoon, so Fund 

Services know what invoices to expect and what payments should be made against a purchase order. 

 

HOW TO REQUEST PAYMENTS IN LRM 

 

Once a Silviculture Contract (also known as PO or Purchase Order) has been created in LRM and issued by 

D365, its status changes automatically to “Active”. The D365 Contract # field gets populated with the 

corresponding D365 contract number, for example, “POamer000075”.  

Once activities have been performed in the field, the FSP is responsible for getting the invoice from the 

vendor and sending it SH-FundAdmin-Timber@btgpactual.com so the invoice can be paid.   

 

***Please note that before sending the invoice to the Shared Box email address, the FSP is 

responsible for requesting payment for that invoice*** 

 

NO INVOICE CAN BE PAID AGAINST A PO WITHOUT PAYMENT FIRST BEING REQUESTED IN LRM 

 

Once the payment request has been made in LRM, an email will automatically be sent to Fund Services 

requesting payment for that invoice. A payment request in LRM will inform D365 and Fund Services that 

the invoice has been verified by the FSP for possible inconsistencies, the executed quantity has been 

adjusted to reflect the actual work that was completed and matches what is on the invoice for the work 

being performed in the field, and the invoice is ready to be processed and paid. 

Step-by-Step Instructions 

Log in to LRM and navigate to the Tree View to the Region > Purchase Unit > Contract-Silviculture Activities 

mailto:SH-FundAdmin-Timber@btgpactual.com
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Select the contract you are requesting payment for, then click the “Silv Act Pymt” tab at the bottom part 

of the screen to see all lines listed in the contract. 

With the invoice sent by the vendor at hand, select the stand(s) for payment, adjust the quantity column 

to match the invoice quantity, and switch the “Pay?” field to Yes. Repeat this step for each stand on the 

invoice if requesting payment for more than one stand.   

 
If, for some reason, the rates/quantities differ from the contract (legal document), an email with an 

explanation must be sent to the Asset Manager, copying Fund Services, requesting approval for the 

rate/quantity difference.  No invoice will be paid if the Asset Manager does not approve the 

rate/quantity difference. 

 

To finalize the payment, hit the save button on the menu. Go to the menu Version > Post to submit your 

payment request to Fund Services/D365. Soon after, Fund Services will receive an email with your 

payment request.  Fund Services will then verify that all the information matches and schedule payment 

for that PO. 

IMPORTANT: If the new, updated price/quantity has a variance greater than 20%, Fund Services will have 

to reach out to the Asset Manager for approval. Price/quantity changes from the original contract must 

also be manually requested to LRM Support AND Fund Services with proper explanations of why it’s 

overwriting the contract (legal document). 

After all line items have been requested for payment in LRM and payment has been confirmed, the 

contract must be closed. Do not forget to send the DUT (database update template) file and to request 

ttg_edits for map updates in case partial treatment happens that requires a stand to be split due to 

differentiation of management. Also, ask LRM Support to remove stand(s) that eventually didn’t get 

treated, but were in the contract. This is very important. Do not close contracts before requesting invoice 

payments. 

  

https://pam-ttg.azurewebsites.net/
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CLOSING A SILVICULTURE CONTRACT 
 

1. Navigate to the Purchase Unit in the Tree View. Click the Contract Silviculture Activities 

node, and select the contract you need to close. Attach documents if necessary, following the procedures 

outlined on page 17 (Closing TS Contracts). 

 

2. Make sure you requested payments for all items (that will need to be paid) in the “Silv Act 

Pymt” tab. If all items are showing “Pay?” = Yes. Save and Post version.  You can leave items that won’t 

need payment as pay=no and still close the contract but once you close the contract it’s final. 

 

3. Please do not switch the contract status field to CLOSED until all payments have been 

confirmed by the FSP. 

 
4. Do not forget to send the DUT (database update template) file and to request 

ttg_edits@ttgforestry.com for map updates if necessary. Ask LRM Support to remove stands that eventually 

didn’t get treated but were in the contract. This is very important. https://pam-ttg.azurewebsites.net/  

 
 

AMENDING A CONTRACT 
 
1. Amending a contract in LRM is a manual process that requires LRM support admin rights 

to do it. 

2. Once the contract expires (end date < current date), the contract must be closed or 

amended. Amendments and new contract end_date must be communicated to LRM Support by e-mail. 

3. If, while amending a harvesting contract, new stand(s) are added to the cutting job, this 

new area must be a new entire stand. If that is not the case, a map update must be requested to ttg_edits, 

a harvesting activity must be added and activated on the stand (see page 10)  and a request for the stand 

to be added to the contract must be sent to LRM Support. The same is true for a silviculture contract. 

 

  

https://pam-ttg.azurewebsites.net/
mailto:ttg_edits@ttgforestry.com
https://pam-ttg.azurewebsites.net/
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Harvesting Contracts (aka S.O.) 

 
Harvesting Contract (SO) Workflow 1 

 
Harvesting Contracts must be entered into LRM so the inventory can be depleted and the 

volume available can be updated quarterly. Contract legal paperwork is done outside LRM 

but must include the same prices and quantities. Please start creating a contract in LRM 

before doing any field work. 

Please follow the steps: 
 
STEP 1 – CREATING THE HARVESTING ACTIVITY: To enter a new timber sale contract in 

LRM, open the Tree View and navigate to the stand(s) that will be involved in the timber 

sale. You will see a “budgeted” and a “non-budgeted” node under the stand. It includes 

the Year and purchase unit in the naming convention. 
 

Budgeted Timbersale Action: If a timber sale was entered during the budgeting process, 

you will see the activity under the “budgeted” option, as shown in the picture below: 

 

Important: If your timber sale was budgeted, skip to STEP 2. NEVER CREATE A NON-

BUDGETED ACTIVITY FOR THE SAME ONE THAT HAS ALREADY BEEN BUDGETED. 
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Non-Budgeted Timbersale Action: If this sale you’re 

entering wasn’t budgeted, you will have to manually 

add this timber sale activity. Right-click on the “20xx-

non-Budgeted” node, point to “New” and then select 

“Activity Harvest”. If the current year is not available, 

you can right-click on the “Historic” node and add the 

activity. LRM will use the start date to create a new 

node if necessary or to place it in the right node for 

that year. 

 

IMPORTANT NOTES:   

-FSPs need to send pre-harvesting inventory data to ttg_edits@ttgforestry.com prior to 

putting a new TS contract in LRM, so depletions can work correctly. 

-FSPs must also send harvesting unit shapefiles or drawings for regions where stands are not 

the harvesting units (northern hardwoods for example). Ttg_edits will then create a new stand 

based on the harvesting unit, and add inventory to it, and FSPs will then be able to pick that 

new stand with the correct boundary to put in the TS contract. 

-For Thinning, post-thin inventory must be sent to ttg_edits the moment, or right after a 

thinning contract is closed.
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The fields in the BOLD header are required on the Activity Harvest page. If in your region 
it’s common to name a timber sale, this can be entered in the “Name”  field. 
 

 
 

Once populated, click the save icon on the Activity Harvest section. Annual budgets are locked once 

approved.  
 

STEP 2 – CHECKING THE VOLUMES/PRICE: Once timber sale activity is selected, verify that the values 

under the “Harvest Volume” tab are correct. This would have either been populated during the 

budgeting process or entered during the non-budgeted process outlined in STEP 1. If the information 

(volumes, species, products, prices) needs to be updated, which frequently is the case, you can do it 

later, on the contract itself (Step 6). If multiple stands are in the same harvest contract, then the Price 

should be the same for LRM to properly summarize at the contract level. Only region-specific booked 

Species/Products are available to enter here; contracted Species/Products will be entered and aligned 

with the booked products in the contract creation step. If there will be multiple contracted products 

depleted from one booked product, an estimated blended price could be entered. 
 

 
 

Right-click on the proper node 
If the current year is not yet in the tree view, right click the Historic Node. Point to Add 
new activity. Once you save the activity, LRM will check the start date of it and create a 
new node in the tree view with that year if it wasn’t yet created. 

Don’t forget to 
enter prices after 
you load/reload 
volumes ! 
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If you want to update the budgeted harvest volumes (and prices) with the most current 

inventory data, set the “Refresh Volume” field to “Y” and save it. LRM will bring the latest inventory 

(pre-harvest or growth) for you. Adjust the prices and the budgeted revenue will automatically be 

updated upon saving the new prices. If creating a harvest activity, use the “Load Volume=Y” first to bring 

the volumes from inventory. Use the “Refresh Volume=Y” if volumes are already present and only need 

to be updated. Check the “Volume Load Comment” field for the status when it finishes refreshing. 

 

 
 
 
 
 

 

STEP 3 – ACTIVATING THE HARVEST ACTIVITY: Once you are ready to add the planned activity to a 

contract, switch the status of the activity to “Active” on the Activity Harvest page. The timber sales 

activity WILL NOT be available to add to a contract until the status is set to ACTIVE in this step. Repeat 

for all stands that need to be added to the same contract before proceeding to the next step. 

 
 
 
 
 
 
STEP 4 – CREATING THE CONTRACT HEADER:   In the Tree View, click on the Purchase Unit that you 
wish to add a Timber Sale Contract to. See the image below regarding where to click. 
 
 
 
 
 
 

Use these fields to refresh volumes. 
Adjust start date to a day after last 

Effective inventory/growth date and 
refresh volume=Y. Save it. 

Don’t forget to activate it or it 
won’t show up in the contract’s pick 

list later on 
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Right-click and point to “New” and select “Timber Sale Contracts”.  
 

 

 

STEP 5 – POPULATING THE CONTRACT HEADER:   After processing, LRM will bring up the Contract Timber 

page where you will need to populate the header fields. Once the items below are completed, click 

the Save icon. 
 

o FSA Ind?: Y E S  i f  this timber sale part of a Fiber Supply Agreement (FSA) or if it’s a delivered logs sale. 
In this case LIMS will handle it and it won’t need to be sent to D365. 

o Logger  FSA: If FSA Ind? Is populated with “YES” then select the customer for the FSA 

o FSA’s THA: This is the number that links LIMS with LRM for volume depletion. 

o CustomerID Non-FSA:  If FSA ind? Is populated with “NO” then select a customer for a regular 

timber sales contract. 

o Sales Type:  PAC, Lump Sum, Salvage, Delivered, etc. 

o Harvest Type:  Final Harvest, Thinning, etc. 

o Start/End Date: Select dates 

o Status:  Leave as “Pending” until you are sure that you are ready to send it to D365. 

Once completed, a contract will be initiated in D365 so this is why it needs to be left as pending for 

this step. Do not send to D365 if it’s  FSA/Delivered=YES. 
 

 
 
 
 
  

If your non-FSA customer/vendor is not listed, you must e-mail Fund Services to get it setup. There's a process in place with a background 
check, ACH and W-9 setup for all vendors that need to be done before it shows up in this list automatically. 
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STEP 6 – PICKING THE STANDS FOR THE CONTRACT:  Once saved, the Contract Timber Activity 

child table will be available. Under the Contract Timber Activity tab, right-click and select Insert. 
 
 
 
  
 
 
 
 
 
 
 
 
 

Select the stands that you wish to add to the contract.  Keep in mind that only the stands that were 

set to “Active” in Step 3 will be available here. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Once the stand has been selected, populate the “Harv Act” field and then select the Save icon 

on the Contract Timber page. 
 

 
 
 
 
STEP 7 – CHECKING CONTRACT VOLUMES AND QUANTITIES:  Once saved, LRM will populate 

the Contract Timber Product tab with the Species, Products, and Quantities from the 

inventory that were verified in Step 2 above. 
 

You must right click on the empty space here - 
In new LRM Version it's called NEW instead of INSERT 
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The Species/Product columns default to auto-populate from the stand inventory 

information selected as part of the contract. However, it’s common for products to be 

included in the contract in more detail than they are carried on the books, and these must 

be correctly assigned to the Inventory Species/Product to ensure depletions are handled 

correctly. In the example above, the contract includes specific prices for Hard and Soft 

Hardwood Sawtimber and Pine Poles, which aren’t in the inventory for the PU. The user 

entered these into the Contract Species and the Contract Product columns and then verified 

the correct Inventory Species and Product were auto-populated for depletion purposes. If you 

have completed this step and feel the incorrect Inventory Species/Product is being 

populated, please notify lrm.support@ttgforestry.com  
 
 

➢ For Lump Sum sales, please load pre-harvest inventory (where applicable) by sending data to 

ttg_edits@ttgforestry.com.   

➢ For Lump Sum sales, please enter your best estimate as to what the buyer paid for each Species/Product 

currently in the inventory. On a Lump Sum sale, the sum of the Quantity * Sales Price must match the 

actual payment value in the contract. 

➢ For Pay-As-Cut sales, the quantity can be zero but you must enter a Sale Price for every record. 
➢ If you’re selling products in units other than what is currently in the inventory for that Purchase Unit (e.g., 

selling by MBF instead of Tons in the South), please right-click and insert a new line. In this new line, 

you’ll be able to enter the new Sale Price UoM (unit of measure) and the price according to that unit. 

Leave the quantity as zero and include a conversion to the unit in the contract and note this in the 

email with the executed contract sent to Fund Services. 
 
 

 
STEP 8 – SEND TO ACCOUTING (if not FSA or Delivered log sale): Once everything is entered and the 

contract is ready to be sent to Accounting (D365) to be executed, switch the status field in the Contract 

Timber Header to “Send to D365”. Click the save button. 
 

Do not forget to fill in the 
prices and quantities - must be 
the same as the legal 
documents. For lump-sum 
sales you might need to use 
Market Value unit prices 
prorated up to actual total sale 
price 

D365 Product Code must match exactly the product/species code Accounting has 
in the books. If that doesn't happen, the contract will be rejected by D365 and the 
property manager will be asked to fix it.  
If you don't have a copy of the current booked species/products in your Purchase 
Unit, please contact Fund Services or LRM Support before putting the contract in 
LRM. Once sent to D365 it's very difficult and time consuming to correct anything! 

mailto:lrm.support@ttgforestry.com
mailto:ttg_edits@ttgforestry.com
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STEP 9: Once everything has been saved, you need to post your version. In the Version menu, click button 

“Post”. This will trigger a system linkup and initiate an official contract request in the Fund Services 

department within the D365 accounting System.

Only submit to D365 if you 
are 100% sure everything is 
right and ready to be 
executed. To reverse it is very 
manual and complicated! 

WARNING:  
IF YOU DON’T POST IT, 
NOTHING GETS SAVED 
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STEP 10 – CONTRACT IS ACCEPTED AND READY TO BE EXECUTED: Once it has been issued, you 

will notice that the D365 ID, Date Created, and FA Confirmer fields will be populated, and the 

status should automatically be set to “Active”. You will record the D365 ID on the physical contract 

and include it in the email Subject you send to Fund Services. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please print out a report from LRM for the TS contract once it's issued by D365 and include it with your 

paperwork. For that, go to the Home Menu and click Reports: 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select the Timber Sale Contract report under the Contracts node. Enter the LRM contract number in 
the box and click the preview button to check it first and/or the export button to a PDF file. 
 
  

This is how you'll see that the 
contract has been created 
and activated in the 
accounting system 
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Harvest Contracts – Special Cases 
 
For Lump Sum Sales, once you receive the first payment, please submit a map update to ttg_edits so the 
stands on the contract can be marked as cutover then close the contract once everything is complete 
(BMP, inspections). For Pay-as-Cut however, only send a map update once the whole contract has been 
finalized and closed. If site prep or planting needs to be done before all stands are cut, you’ll have to ask 
ttg_edits for the stands to be split beforehand. Whenever possible,  put new stand numbers on the 
standing pieces and keep current stand numbers on the stands that are in the contract. 
 
Understandably,  it is often necessary to engage with site prep and reforestation contractors well in 
advance of planned activity to ensure their availability and confirm future scheduling.  When this need 
arises, we ask that you utilize the following protocol: 
 

• Confirm the plan regarding stand(s), site prep, and reforestation contractor, needed prescription, and 
rate with the asset manager. 

• Enter the contract information into LRM (Vendor, associated stands, and expected area and rates), but 
leave the Status field as “Pending”. You’ll get an LRM Contract ID even if it’s pending – use this code for 
now. 

• Work with the asset manager and vendor to construct the contract and have it fully executed. 

• At the point when the site prep activity begins, work through the following key: 
o If the timber sale associated with the stand(s) is complete, please confirm the timber sale contract is 

marked as “Closed” in LRM, and the associated map updates have been completed at the stand level and 
the stands now show as cutover. 

▪ Navigate back to the silv contract in LRM, update with correct acres/rates if needed, set the Status field 
to “Send to D365” and post your version. You should get a D365 Contract # within 24 hours if all is correct. 

▪ Provide the D365 Contract # to the asset manager and vendor for invoicing purposes. 
o If the timber sale associated with the stand(s) is still ongoing, you can’t close the TS contract just yet nor 

set the completed stands as cutover or we’d be over-depleting the inventory.  
If you’re at the point where the field site-prep activities are being executed and you need to pay the 
invoices in the “pending” contract, you’ll need to go ahead and request a map update to split out the parts 
not yet harvested into new stands. Only then can you activate and pay the site prep contract.  When you 
send in this update request, please flag it as “Urgent” in the title of the email and briefly explain the case, 
asking not to change original stand IDs for those stands that are still in the contract. New stand IDs will 
have to be created for the split pieces. 

▪ Wait for the map update to be completed and then navigate back to the site-prep silv contract in LRM, 
update acres, or pick the new stands for the site-prep contract. You will see two new fields with live view 
columns in the stand table that can help you observe if the map updates are complete before sending to 
D365: 
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▪ Once everything is in order, set the contract status field to “Send to D365”. Post and wait for the contract 
to be issued. 

▪ To provide a contract report to asset manager and vendors for invoicing purposes is always a good 
practice. 

 

• For Interplanting, please add a comment on the comments field (the bottom part of the contract screen 

- stand lines) to indicate what is the original Establishment year of that stand so Fund Admin can 

correctly allocate the costs. 

• If the interplanting is for a stand that had a major planting failure (usually >50%), FSPs should use 

“planting (Regeneration)” activity instead of interplanting and have the stand be set to cutover or 

undefined beforehand. A comment is also very welcome by the Fund Services staff. 

 

 

Closing Timber Sales Contracts 
 
The Timber Sale contract will eventually be complete, and all stands in it will be cutover. Once that 

happens you have to submit to ttg_edits@ttgforestry.com a map update request so LRM can be updated 

from a planted stand to a cutover stand and it will release it for site prep work and contracting. 

 

Once a Timber Sale contract is complete, the BMP Auditing form in PDF format (template found in the 

remote folder on the cloud) must be filled out and attached to the contract header (figure below) along 

with the harvest summary report showing all amounts and depletions received, along with any other 

documents you find to be important. Contract status must be set to “CLOSED”. It shouldn’t happen, but if 

BMP are done after contract closing, send the form file to the LRM Support for uploading. 

What to do?  

➢ Navigate to the Purchase Unit in the Tree View.  

➢ Click the Contract Timber node, and select the contract you need to close.  

➢ Find the field “Related Docs” and click on the three dots button (…). A new window will be displayed where 

you can attach documents.  

➢ Click New, select the type of file (pdf usually), and type something as description and group. 

➢ On the Path or URL field, paste the URL of the document stored in SharePoint or click the folder button 

and navigate to the folder where the file to upload is. 

Make sure you’re going to your local machine (TSclient) and not the remote server. Upload to Virtual drive 

if using the AVD Web 

➢ Once everything is filled out and file is selected, click Apply to save it and hit Done. 

mailto:ttg_edits@ttgforestry.com
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➢ Once documents are attached, set STATUS FIELD of the contract to CLOSED. Hit the Save button on the 

main menu. Go to the menu VERSION and click POST 

➢ Important: Always send in the DUT (database update template) file and request ttg_edits for stand splits 

if parts remain uncut or LRM Support to remove from contract stands that eventually didn’t get cut.  

➢ Lump Sum Contracts must have their stands marked cutover in the same quarter the payment is 

received by Fund Services. Keep the contract open until BMP is complete. 

 

 

Harvest Contracts – FAQs 

 
What if the stand requires site prep and is still in an active harvesting contract? 
 
A logic change is now allowing site prep on stands that are still in active harvesting contracts was 
implemented in LRM recently. From now on, you can add stands that do not require splitting or map 
updates to site prep and even planting contracts without having to set them to cutover first. You’ll still 
see a warning message telling you that you shouldn’t do it, but you can just click OK and move forward 
anyway. Refer to page 25 for more details. 
 
 

What if the Timber prices changed during the contract? 

 
It should be accompanied by an amendment in most cases. If the harvesting job hasn’t started yet, the 
Regional Manager can approve by e-mail the changes in product price and the 
lrm.support@ttgforestry.com staff can update them in LRM and D365. 
The same is true if quantities and products change or need to be added. Try to keep only stands that 
should be completely harvested during the same semester to avoid keeping the contract open just 
because one stand was not cut among many others. You cannot close contracts unless all stands are cut 
(see next topic if not all stands are going to be cut). 

https://pam-ttg.azurewebsites.net/
mailto:lrm.support@ttgforestry.com
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What if I didn’t harvest all the stands in the TS contract? 
 
In the case not all the stands have been cut, you will have to email lrm.support@ttgforestry.com asking 
for that stand to be removed from the contract. 
 
Once that is done, navigate to the stand’s budgeted (now active) harvesting activity and change its status 
to “canceled” and save; or change it to planned and move the start date to the future if it’s going to be 
cut within the current budgeted year. 
After that, you can close the contract and submit the DUT and map update request to ttg_edits. 

 

What if the logger left patches of uncut timber in the stand? 
It’s not uncommon, especially in the Pacific Northwest and 
Northern hardwoods, for patches of uncut timber to be left 
out after harvesting is complete. The image on the side 
shows that. It is up to the field forester and, with the help 
of the map portal and the GIS person in the company, to 
check that using a imagery layer like Sentinel-2 and inform 
ttg_edits@ttgforestry.com to update LRM and maps 
accordingly. 
Large roads and highways should also be digitized out of 
productive area and be flagged as such in the systems and 

maps for better forest inventory accuracy. 

 
 

https://pam-ttg.azurewebsites.net/
mailto:ttg_edits@ttgforestry.com
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PRINTING CONTRACT REPORTS 
 

In LRM you can find preset reports for Timber Sales Contracts (aka SO) and Silviculture contracts 

(aka PO). To print them, first note the LRM Contract ID # for the contract you want to print. 

 
 

Once you find the code for the contract you need – in this case, let’s use TS contract 703 as an 

example – click the Home Menu > Reports button. 

 

 
 

Then click “Preview” to see the report. From this window you can print and export to several file 

formats, including PDF and Excel. 
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MAPS 

Requesting a Map Update 
 

You can request changes in the data for the properties you manage in two ways. 
1) Via MURS web form: Recently TTG deployed MURS (Map Update Requesting System) where you 

can fill out a form to request an update. Access it via https://arcg.is/1Lm1qj (or the QR code 
below). Parts of the form is shown in the picture below:  

 
 

2) Emailing TTG Edits: You can e-mail files and any update request such as map updates, tabular 
updates, harvest units, new inventory data, corrections, or anything related to the email 
ttg_edits@ttgforestry.com 

 
 
 

 

https://arcg.is/1Lm1qj
mailto:ttg_edits@ttgforestry.com
https://survey123.arcgis.com/share/a6385a59d5204aab8efcda481137ec4c?
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Accessing Maps in LRM 
 
Although you have geo-enabled PDF maps updated every quarter in the remote Maps and Files folder, 
you might want to produce your maps for whatever reason. To have access to recently processed map 
updates, layers that are required by SFI, and other information, you have the option of opening LRM’s 
mapping interface to explore the spatial data from your desktop. 
 

• To open it, right-click on a Purchase Unit, Tract, or Stand and select  “Send to Map View”. 

• If that option is greyed out, hit File>Options. Under “License”, make sure “ArcView” is selected. If not, 
select it and hit OK; restart LRM. 

 
After sending it to Map View, a map window will load. It will look very similar to ArcMap if you’re 
familiar with it. You can add other layers to the map such as soils, SFI, streams, restrictions, conservation 
areas, T&E and many others by clicking map View menu FILE> ADD SYSTEM DATA and checking the 
layers you want to load. LRM Map viewer video training – click here to watch a short YouTube demo. 
 

 
If your map window doesn’t get sized properly, please check your screen resolution. It’s probably too 

high. 

 

https://www.youtube.com/watch?v=VFzNbG-MxLI
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Creating Map and Report Packages in PDF 

Package Generator in LRM 
 

Create a Harvesting Package: 
• In LRM, Open the Query Builder 

• Open the Contract Timb Listing (SO)>All queries>All SO InfoType (as shown in the image below) 

• Right-click>” Auto Filter Enabled”. Filter the Contract ID you want a package for. Select one or all 
the stands (holding the Ctrl key) in the contract. 

•  
• With stands selected, click the “Create Harv. Package” button on the right-hand side. 

• Select what Packaging template to be used (Generic for all Regions or Crown Pine specific for 
that project) 

 
• Select your preference for grouping if more than one stand was selected. If you want just one 

package per stand or if you prefer a single PDF file with all stands in it. The latter might work best 

for harvesting. 

• In “Output to”, pick a directory (if one file per feature) or a file path (path\myfile.pdf, if one file 

with all stands) in your local machine (C:/Temporary). Make sure you’re not exporting to the 

Server’s C drive instead or the file(s) won’t be accessible. 

• Hit OK to start generating the packages. It will take a while depending on the number of stands 

and the size of the selected package. [Go grab a coffee] 

• Wait until you see the message that your package was successfully generated. 

• Your package should now be available in the output folder or file you selected above (and shown 

in the message mentioned in the step above as well).  
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Create a Silviculture Package (Stand Establishment): 
• In LRM, Open the Query Builder 

• Open the Data Download InfoType 

• Right-click> “Auto Filter Enabled”. Filter the Purchase Unit and the Stand Keys you want to export 

a package for 

 
• If more than one stand (compstand) is going to be in the package, hold the Ctrl key and select all 

the stands as shown in the image above. 

• Click the “Package Gen…” button on the right-hand side. 

 
• On the Window that pops up, select what package you want to generate. In this case, a 

Silviculture-Stand Establishment Package. 

 
• Select your preference for grouping. If you want just one package per stand or if you prefer a 

single PDF file with all stands in it. One package per feature works best at this point for Silv 
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• In “Output to”, pick a directory (if one file per feature) or a file path (if one file with all) in your 

local machine (if on AVD Web, use C:/Temporary). Make sure you’re not exporting to the Server’s 

C drive instead or the file(s) won’t be accessible. 

• Hit OK to start generating the packages. It will take a while depending on the number of stands 

and the size of the selected package. [Go grab a coffee] 

 

 
 
 

• Wait until you see this message: 

 
 

• Your package should now be available in the output folder or file you selected above (and shown 

in the message above as well).  

 
PS: This is an automated product and might not look exactly like you wanted it to be. Ask your local GIS person to 
adjust the MXD templates if needed. 
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Creating PDF Maps using the Map Manager 
 
LRM lets you create simple PDF maps in pre-defined templates. New Templates are being added to LRM 
from time to time.  
You can use this procedure to create simple maps to add to contracts or to print and take with you to the 
field. Some Timber Sale projects might require more than a standard map, especially if the sale does not 
encompass full stands. In this case, the GIS analyst in charge of your area should be able to create it for 
you. To create a map using the LRM standard templates, please follow the steps below: 
Steps: 

• From the Home Menu ribbon, click on Maps. You can also right-click a Tract or Stand and point to Send> 

Send to Map Manager 

 
 

• If you clicked the Maps icon, Select “Run Map Manager” and hit OK 

 

• Select Mappable features and hit Next  
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• Select Stands or Tracts on the feature type. Try to avoid selecting stands from more than one Tract at once 

for better-looking maps. Hit Next. 

 
 

• Select the map template(s) you want to use. Select the level of zoom around the selected features (110 

to 120% should work well). In the Map grouping, you can choose if you want to have only one file with all 

the selected stands on it or one map file per selected stand. Hit Edit to choose the page size and others. 

Hit Next. 
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• On the Map output window, select if you want to print it or export it as a file. You can export as images 

(png, jpeg, etc.) for contract documents or GeoPDF. On the output option, be careful to select a path on 

your local machine and not on the LRM server where you cannot access the file later. To save on the root 

of your C drive please enter C:/Temporary (It is advisable to create a LRM Export folder on your C drive to 

always use for this purpose so you don’t need to change the path every time). The DPI is the map quality 

you want to export. Try not to choose a value higher than 300 or it will take a lot of time to create the file 

and it will be big in byte size. Hit Next 

 
• Review the map summary and hit Finish to generate the map. After this, LRM might take several minutes 

to complete the task and ArcMap will flash. Do not close it. Check your folder once it completes to find 

your file there. 

 

file://///tsclient/C/
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INFOTYPES, QUERYING, AND EXPORTING TABULAR DATA 
 

THE INFOTYPE PANEL 
InfoType is the name in LRM of a set of predefined queries (searches) where you can easily access 

tabular data from several tables and a combination of tables in the system. 

 

Step 1: The first step to gain access to the InfoTypes is by clicking Home Menu and then Builder. 

 
 

Step 2:  If this is your first access, your InfoType panel will be shown behind the main panel (it 

should work now in LRM 5.5). This is because it was designed to be dragged and placed on a 

second screen. If you only have one, place the InfoType panel where you can use it;  click its title 

bar and hold it, while holding, drag it and drop it into the centerpiece of the floating icon that will 

be displayed, as shown below. Drop it in the middle of it. 

 

 

 
If your screen gets messy you can reset the layout (See page 7 for instructions) 

Now it should be visible. You can now toggle between the InfoType (Query Builder) window and 

the Data window at the bottom of the screen. Don’t forget to toggle back to Data View when 

you’re using the Tree View and to Query Builder when you want to get tabular data out. 
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INFOTYPES 
 

Depending on your access level in the LRM application, you will see a list of predefined queries 

that pull data from several tables in the system and make them readable in plain text. 

The image below shows where to click to see the list of InfoTypes you have access to. 

 
The most used InfoTypes are: 

• the “Data Download” which contains inventory and main stand-level data fields necessary for 

management. The plain “Data Download” query is designed to be used for Purchase Units located 

in the US South while DD-APP Inventory is designed to be used for the Appalachian properties, 

LS in the Lake States, NE in the Northeast, and PNW in the Pacific Northwest region. You can see 

which region your PU is located easily in the Tree View. 

• Master PU infotype is used for Asset Managers to approve Quarterly Data Changes. 

• Contract Silv Listing and Contract Timber Listing show all the contracts entered in LRM to date. 

Not all users have access to all these InfoTypes as it goes by your role within the organization. 

 

VIEWING AND EXPORTING DATA 
 

Once you pick the Infotype you will use, on the next arrow, you will pick which query to view. 

Usually, you can pick the “All” one to see all the data. Sometimes you will see other options such 

as “Prompt for a PU” and LRM will ask you to pick your Purchase Unit to filter down the data. 
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Once you pick your PU you will see all the data in the grid. The grid is Excel-like. You can right-

click and enable Auto Filter and it will display a smaller filter icon just like Excel and you will be 

able to filter down data the way you want before exporting it. 

   
 

 

 

 

 

 

 

 

 

 

 

 

To export data, you can right-click on the grid and select “Export Data” to export all rows or you 

can select the rows first (holding Ctrl and picking your rows) and then right-clicking and choosing 

“Export Selected Rows”. 

On the “Save As” window, choose the format you 

want in the Type dropdown (.xlsx for instance). Save 

on your local computer and not in the remote server 

by pointing to Network and navigating to your folders. 

If you created a LRM Export folder in your C drive as 

we recommended on page 34, place it there. 
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PRINTING REPORTS 
 

THE QUARTERLY SUMMARY REPORT (QSR) 
 
One very important report in LRM is the Quarterly Summary or Quarterly Change Report. It shows a 
picture of the assets at the end of each quarter including merchantable breakdown from the end of the 
previous quarter adding growth, ingrowth (moves from premerch to merch), Inventory adjustments, 
complete and active harvest volumes removals, land sales removals and map update adjustments to get 
to the end of the quarter volume. Pre-merchantable area figures before and after and a section for Land 
totalization per land cover type. 

 
➢ QSRs are different depending on the region of the property. On the reporting selection tool 

(Home>Reports) you’ll find the QSR section where you can select the PU for the region in the tree view. 
Appalachian, Northeast, and Lake States are in the first one. Pacific Northwest areas is the second one 
and the third one is for everything in the US South. 
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➢ Asset managers must approve the numbers in this report at the end of each quarter. They have to use 

the Master PU InfoType to approve them. 

 

THE CURRENT SUMMARY REPORT (CSR) 
 
The CSR report shows a current picture of the assets at the date it is generated. It can be generated at 
Purchase Unit or Tract-Level, and it displays merch, premerch and land classes. It can also be created for 
archived tracts by entering the year and quarter the tract was last active. 
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TROUBLESHOOTING 
 
Most common LRM problems and how to solve them yourself: 
 
1-When launching the app from the connector sometimes it won’t show up in full screen but on 
a small minimized window on the right lower corner of your screen. 
Solution: That is a known glitch Trimble has not fixed yet. When this happens find the corner of 
the window (in the red frame below), click and drag it to make the window bigger. Once you can 
see the maximize button click on it and you should be able to see LRM in normal window size. 

 
2-When you try to look at a data table it shows up like a form or card view instead of a normal 
grid (Excel-like). 
Solution: Sometimes LRM will lose its grid-type settings and revert to card or form view. To fix 
that, right-click on the empty gray space (where the arrow is) and uncheck the form or card view 
on the menu. You can also click on the grid button on the main menu. 
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3- When you click the Builder (infotype) to see your data tables, but the window gets stuck 
behind the main data panel and you don’t see a thing but the header “query builder”: -(This 
should work fine in LRM 5.5) 
Solution: This is another glitch in LRM that Trimble has not fixed yet. Please also check page 27. 
To make it visible, click on the title bar (red x below) hold, and drag it until a floating docking icon 
shows up then place your mouse on the center icon and drop the window there. It will dock and 
be visible 
 

 

 
You can toggle between the InfoType (Query Builder) window and the Data window at the 

bottom of the screen now. Don’t forget to toggle back to Data View when you’re using the Tree 

View and to Query Builder when you want to get tabular data out. 

4-Reconcile error on LRM status bar 
 Solution: When this error appears, you shouldn’t enter any new data in LRM until you solve it or 
you’ll lose it. To solve this issue double-click where it says, “reconcile error” in the status bar and, 
on the window that pops up, click “Cancel”. Reboot LRM. 
This should solve the problem but if it persists please contact LRM support. 

 
 
 

5-My password is expired. What should I do now? 
 
Solution: You may see a message like the one below when trying to log in. Or, if you’re using the 
system while the password expires, you might see a different message, in which case just close 
LRM, head to your browser, and type www.ttgforestry.com/remote. Try to log in with your 
known credentials. It will say it’s expired and guide you through the steps to change it. If you 
can’t get it changed, please contact lrm.support@ttgforestry.com and 
support_us@btgpactual.com or your local BTG IT Support person. 

 

mailto:lrm.support@ttgforestry.com
mailto:support_us@btgpactual.com
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5-Purging local layers in case of ArcGIS Drawing errors 
 
If you’re getting a drawing error in LRM spatial view, like the one in the figure below, please follow these 
steps to fix it. 

 
Drawing error in LRM spatial view 

 
Workaround: 
 

• With the map view closed, go to the menu File > Options then “Purge Files” item. 

• Hit all four “purge” buttons; 

• Go to “Layers” tab 

• Make sure no checkbox is checked in this tab and “Automatically update files from server” is selected in 
the dropdown 

• Click the “Purge Local Files” button.  
Click OK, close, and re-open LRM. 
 
You should be able to see the stands symbolized with colors and no drawing errors (joined stand layer 
w/ data download info type as well). In case your problem persists, please contact LRM Support. 
 

6-My “Map” button or “Send to Map View” is greyed-out 

If you can’t see maps or Send to Map View when right-clicking a stand or tract, it’s because you 
haven’t selected a spatial license to use in LRM.  
To fix that, Click LRM File Menu, then Options. Click License under Map View and make sure at 
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least ArcView is selected in the drop down. 

 
 
 

FREQUENTLY ASKED QUESTIONS – FAQs 
 

▪ How to Submit a Map Update? 
Map updates, inventory updates, and estimates, Land sales spatial updates, silv and TS ops updates, and 
anything related to record updates should be submitted to ttg_edits@ttgforestry.com. Recently a web 
form was deployed so you can just fill it out here and request an update from any device. 
 

▪ The "Blackout period"? 
A blackout period is usually 10 days prior to quarter-end where the staff holds off any new updates in the 
system to generate client reports without the daily fluctuation in the market value, we normally observe 
due to regular operations. During it, no map updates, inventory loads, TS contract closing, or creation is 
allowed. Silviculture contract creation and payment requests are allowed. 

 
▪ I need Support with LRM. What to do? 

LRM Support email is available so users can request help with the usage of the LRM system and Contract 
Management only. Email your question to lrm.support@ttgforestry.com. Expect to receive an answer 
within 2 business hours unless there is a message here saying that support is not available during that 
week. You can also call 404 789 1951 
 
 

▪ What needs to go through LRM? 
Usually what needs to be in LRM are silviculture services contracts for Fertilization, Inventory, Pest 
Control, Regeneration (planting), Release, and Site prep ONLY. General services that aren't done at stand 
level like fence work and road maintenance, for example, should be sent directly to Fund Services. 
- Timber sales contracts need to be initiated in LRM starting in August 2018. 

mailto:ttg_edits@ttgforestry.com
https://survey123.arcgis.com/share/a6385a59d5204aab8efcda481137ec4c?


 

47 | P a g e  
TTG Forestry | Land Resources Manager User Guide – Version 18.0 

 
 

 
▪ Do you provide phone support? 

We sure do: Call 404 789 1951 

 
▪ What do to if the Vendor/Customer is not in LRM? 

 
- There is a process in place to add a new VENDOR to the LRM dropdown list. Background checks and 
compliance approval are necessary. Please request the setup form to the email SH-FundAdmin-
Timber@btgpactual.com copying LRM. Support. Once it is set up in D365 it will automatically show up in 
LRM about 1 hour later; TTG cannot add customers or vendors directly in LRM without this process being 
completed first.  
-Copy of the forms are available in the Maps &Files folder (templates) 
 

▪ What do to if I’m getting errors? 
 
Please refer to the “Troubleshooting” session or contact lrm.support@ttgforestry.com  
  

mailto:lrm.support@ttgforestry.com
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ANNEX I – List of LRM Info Types (List of queried data tables) 
INFO TYPE 

NAME 
DESCRIPTION USER ACCESS 

Acreage Report A Year/Quarter/Tract level break down of Book Area and GIS Area. TFM_ADMIN_ROLE, , 
,TFM_PROPERTY_MANAGER_ROLE,TFM_ASSET_MANAGER_ROL
E 

Actualized 
Actions 

Details of Stand level Activities that have been Completed. TFM_ADMIN_ROLE,TFM_ASSET_MANAGER_ROLE,TFM_PROPERT
Y_MANAGER_ROLE 

Annual Growth 
Rates 

Editable info type to set Growth Rates by PU/Product/Species. 
Used in Grow by Percent procedure. 

TFM_ADMIN_ROLE 

Archived 
Locations 

A list of Stands and Tracts that have been Archived. Editable to 
Admin users to "un-archive" if necessary. 

TFM_ADMIN_ROLE 

Budget - Harvest 
Activities 

A list of Harvest Budget details. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE,TFM_VIEW_ROLE,TFM_P
ROPERTY_MANAGER_ROLE,TFM_ASSET_MANAGER_ROLE 

Budget - Silv 
Activities 

A list of Silv Budget information. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_ASSE
T_MANAGER_ROLE 

Budget - Silv 
Activities Detail 

Silv Budget information with more details. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_ASSE
T_MANAGER_ROLE 

Budget - Silv 
Quarterly 

Silv Budget info and values by Quarter. TFM_ADMIN_ROLE, 
,TFM_PROPERTY_MANAGER_ROLE,TFM_ASSET_MANAGER_ROL
E 

Budget - Silv 
Yearly 

Silv Budget info and values by Year. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Budget Harvest 
Volumes 

A child info type under Budget - Harvest Activities providing 
volume info for the selected Harvest. 

_ 

Clean Stand 
Lister 

Stand level Details. TFM_GIS_ADMIN_ROLE,TFM_ADMIN_ROLE,TFM_ASSET_MANAG
ER_ROLE 

Context List Information about the Contexts in BTGs system, for Admin use. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Contract Silv 
Listing 

Lists all Silv Activities that are attached to Contracts. GD_ADMIN,TFM_VIEW_ROLE,TFM_MODIFY_ROLE,TFM_ASSET_
MANAGER_ROLE 

Contract Timb 
Listing 

Lists all Harvest Activities that are attached to Contracts. GD_ADMIN,TFM_VIEW_ROLE,TFM_MODIFY_ROLE,TFM_ASSET_
MANAGER_ROLE 

Current Quarter Editable info type to set the Current Quarter which is used in 
Quarterly Processes. 

TFM_ADMIN_ROLE 

D365 Growth 
and Adjustments 

Quarterly volume data formatted for import to D365 BTG_ARYTWINSKI,TFM_ADMIN_ROLE,BTG_JBARBIERI,TFM_ASSE
T_MANAGER_ROLE 

Data Download Stand-level Data Download GD_ADMIN,TFM_ADMIN_ROLE,TFM_ADMIN_ROLE, 
,TFM_PROPERTY_MANAGER_ROLE, , 

Data Download - 
APP Inventory 

Inventory data specifically for Appalacian region TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
APP Inventory 

Also used as a child info type under Data Download TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
LS Inventory 

Inventory data specifically for Lake States region TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
LS Inventory 

Also used as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
NE Inventory 

Inventory data specifically for North East region. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
NE Inventory 

Also used as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
PNW Inventory 

Inventory data specifically for PNW region. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Data Download - 
PNW Inventory 

Also used as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_AD
MIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

DB Update 
Template Stand 
Data 

An info type used to format stand data for loading into the DB 
Update Template each quarter. 

TFM_ADMIN_ROLE 

DTM Errors A list of current error records in the DTM. Custom buttons are 
available to help clear these errors. 

TFM_ADMIN_ROLE 

Exception PU 
Area 

Shows if there are differences between a PU area and the sum of 
its stands' area. 

TFM_VIEW_ROLE 

Exception Stand 
Overlap 

Shows if any stands overlap spatially NOTE - I see this was make by 
TTG, it looks like it does not respect the stand Archive Ind. 

TFM_ADMIN_ROLE 
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Fund Acres Fund level Book Area and GIS Area. TFM_ADMIN_ROLE 

Growth Export - 
Baseline 

Stand level volumes from Baseline Inventory. Used to export for 
growth. 

TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Growth Export - 
Baseline 

Appears as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Growth Export - 
Current 

Stand level volumes from latest growth record. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Growth Export - 
Current 

Appears as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Harvest Contract 
Stands 

Lists stands linked to Harvest Contracts. TFM_ADMIN_ROLE 

Height and Site 
Index 

Editable info type showing Height and SI info for stands. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Height and Site 
Index 

Appears as a child info type under Data Download. TFM_ADMIN_ROLE,TFM_ADMIN_ROLE 

Inventory 
Baseline 

Stand Baseline Inventory details at the Product/Species level. TFM_VIEW_ROLE 
,TFM_ADMIN_ROLE,TFM_ASSET_MANAGER_ROLE 

Map Update 
Transfer 

Stand Data info used to upload to D365. TFM_ADMIN_ROLE 

Master PU PU level info type with custom buttons and child info types. Used 
to run quarterly processes. 

TFM_ADMIN_ROLE,TFM_ASSET_MANAGER_ROLE, 

Purchase Unit Purchase Unit information. TFM_VIEW_ROLE,TFM_ASSET_MANAGER_ROLE 

Quarterly 
Change 
Summary 

Stand level details of change by quarter, giving BEFORE and AFTER 
values. 

TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE,TFM_ASSE
T_MANAGER_ROLE 

Quarterly 
Depletions 

A list of Depletions by Year/Quarter/PU/Contract. TFM_ADMIN_ROLE 

Quarterly 
Harvest 
Transactions 

Lists harvest transactions that were loaded manually as a 
temporary solution before Depletions were working. 

TFM_ADMIN_ROLE,TFM_ADMIN_ROLE,TFM_ASSET_MANAGER_
ROLE 

Quarterly Land Quarterly areas at the PU level. TFM_ADMIN_ROLE,TFM_PROPERTY_MANAGER_ROLE 

Quarterly Land 
by Tract 

Quarter areas at the Tract level. ,TFM_ADMIN_ROLE 

Quarterly Merch Quarterly Merch data at the PU level. TFM_PROPERTY_MANAGER_ROLE,TFM_ADMIN_ROLE 

Quarterly Merch 
by Stand 

Quarterly Merch data at the Stand level. TFM_ADMIN_ROLE 

Quarterly Merch 
by Tract 

Quarterly Merch data at the Tract level. TFM_ADMIN_ROLE 

Quarterly 
Premerch 

Quarterly Premerch area at the PU level. TFM_PROPERTY_MANAGER_ROLE,TFM_ADMIN_ROLE 

Quarterly 
Premerch by 
Tract 

Quarterly Premerch area at the Tract level. TFM_ADMIN_ROLE 

Quarterly Stand 
Data 

Stand data by Quarter, providing a snapshot of all Stands each 
Quarter. 

TFM_ADMIN_ROLE 

Quarterly Stand 
Volume 

Stand volumes by Quarter, as a child info type of Quarterly Stand 
Data. 

TFM_ADMIN_ROLE 

Species 
Groupings 

Shows all Products/Species by Region and how the are grouped 
into Product Group/Species Group. 

TFM_ADMIN_ROLE 

Stand Stand info. Created directly from Stand Context using LRM tool. TFM_SECURITY_ROLE,TFM_ASSET_MANAGER_ROLE,  

Stand Detail 
Update 

Editable info type to update stand details. TFM_ADMIN_ROLE 

Stand Volume 
Groups 

Shows all Volume Groups by Stand. TFM_ADMIN_ROLE 

Stand Volume 
Projection 

Shows all Volume Projection Groups by Stand. TFM_ADMIN_ROLE 

Tract Tract info. Created directly from Tract Context using LRM tool. TFM_VIEW_ROLE,TFM_ASSET_MANAGER_ROLE 

Validations Shows any stand that breaks validation rules with a description of 
the broken rule. 

TFM_ADMIN_ROLE 

 


